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IntroductionIntroduction
►A self-healing system “…automatically A self-healing system “…automatically 

detects, diagnoses and repairs localized detects, diagnoses and repairs localized 
software and hardware problems” – software and hardware problems” – The The 
Vision of Autonomic Computing 2003 IEEE Computer Vision of Autonomic Computing 2003 IEEE Computer 
SocietySociety
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ChallengesChallenges
►How do we evaluate the efficacy of a self-How do we evaluate the efficacy of a self-

healing system and its mechanisms?healing system and its mechanisms?
 How do we quantify the impact of the How do we quantify the impact of the 

problems these systems should resolve?problems these systems should resolve?
 How can we reason about expected benefits How can we reason about expected benefits 

for systems currently lacking self-healing for systems currently lacking self-healing 
mechanisms?mechanisms?

 How do we quantify the efficacy of individual How do we quantify the efficacy of individual 
and combined self-healing mechanisms and and combined self-healing mechanisms and 
reason about tradeoffs?reason about tradeoffs?

 How do we identify sub-optimal mechanisms?How do we identify sub-optimal mechanisms?
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MotivationMotivation
►Performance metrics are not a perfect Performance metrics are not a perfect 

proxy for “better self-healing capabilities”proxy for “better self-healing capabilities”
 Faster != “Better at self-healing”Faster != “Better at self-healing”
 Faster != “Has better self-healing facilities”Faster != “Has better self-healing facilities”

►Performance metrics provide insights into Performance metrics provide insights into 
the feasibility of using a self-healing the feasibility of using a self-healing 
system with its self-healing mechanisms system with its self-healing mechanisms 
activeactive

►Performance metrics are still important, Performance metrics are still important, 
but they are not the complete storybut they are not the complete story
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ProblemProblem
►Evaluating self-healing systems and their Evaluating self-healing systems and their 

mechanisms is non-trivialmechanisms is non-trivial
 Studying the failure behavior of systems can Studying the failure behavior of systems can 

be difficultbe difficult
 Finding fault-injection tools that exercise the Finding fault-injection tools that exercise the 

remediation mechanisms available is difficultremediation mechanisms available is difficult
 Multiple styles of healing to consider (reactive, Multiple styles of healing to consider (reactive, 

preventative, proactive)preventative, proactive)
 Accounting for imperfect repair scenariosAccounting for imperfect repair scenarios
 Partially automated repairs are possiblePartially automated repairs are possible
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Proposed SolutionsProposed Solutions
►Studying failure behaviorStudying failure behavior
 ““In-situ” observation in deployment In-situ” observation in deployment 

environment via dynamic instrumentation toolsenvironment via dynamic instrumentation tools
►Identifying suitable fault-injection toolsIdentifying suitable fault-injection tools
 ““In-vivo” fault-injection at the appropriate In-vivo” fault-injection at the appropriate 

granularity via runtime adaptation toolsgranularity via runtime adaptation tools
►Analyzing multiple remediation styles and Analyzing multiple remediation styles and 

repair scenarios (perfect vs. imperfect repair scenarios (perfect vs. imperfect 
repair, partially automated healing etc.)repair, partially automated healing etc.)
 Mathematical models (Continuous Time Mathematical models (Continuous Time 

Markov Chains, Control Theory models etc.)Markov Chains, Control Theory models etc.)
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HypothesesHypotheses
► Runtime adaptation is a reasonable technology for Runtime adaptation is a reasonable technology for 

implementing efficient and flexible fault-injection toolsimplementing efficient and flexible fault-injection tools
► Mathematical models e.g. Continuous Time Markov Mathematical models e.g. Continuous Time Markov 

Chains (CTMCs), Markov Reward Models and Control Chains (CTMCs), Markov Reward Models and Control 
Theory models are a reasonable framework for analyzing Theory models are a reasonable framework for analyzing 
system failures, remediation mechanisms and their system failures, remediation mechanisms and their 
impact on system operationimpact on system operation

► Combining runtime adaptation with mathematical models Combining runtime adaptation with mathematical models 
allows us to conduct fault-injection experiments that can allows us to conduct fault-injection experiments that can 
be used to investigate the link between the details of a be used to investigate the link between the details of a 
remediation mechanism and the mechanism’s impact on remediation mechanism and the mechanism’s impact on 
the high-level goals governing the system’s operation, the high-level goals governing the system’s operation, 
supporting the comparison of individual or combined supporting the comparison of individual or combined 
mechanismsmechanisms
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Runtime Fault-Injection ToolsRuntime Fault-Injection Tools
►Kheiron/JVM (ICAC 2006)Kheiron/JVM (ICAC 2006)

 Uses byte-code rewriting to inject faults into Uses byte-code rewriting to inject faults into 
running Java applicationsrunning Java applications

 Includes: memory leaks, hangs, delays etc.Includes: memory leaks, hangs, delays etc.
 Two other versions of Kheiron exist (CLR & C)Two other versions of Kheiron exist (CLR & C)
 C-version uses Dyninst binary rewriting toolC-version uses Dyninst binary rewriting tool

►Nooks Device-Driver Fault-Injection ToolsNooks Device-Driver Fault-Injection Tools
 Developed at UW for Linux 2.4.18 (Swift et. al)Developed at UW for Linux 2.4.18 (Swift et. al)
 Uses the kernel module interface to inject faultsUses the kernel module interface to inject faults
 Includes: text faults, stack faults, hangs etc.Includes: text faults, stack faults, hangs etc.
 We ported it to Linux 2.6.20 (Summer 07)We ported it to Linux 2.6.20 (Summer 07)
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Mathematical TechniquesMathematical Techniques

►Continuous Time Markov Chains (PMCCS-8)Continuous Time Markov Chains (PMCCS-8)
 Reliability & Availability AnalysisReliability & Availability Analysis
 Remediation stylesRemediation styles

►Markov Reward Networks (PMCCS-8)Markov Reward Networks (PMCCS-8)
 Failure Impact (SLA penalties, downtime)Failure Impact (SLA penalties, downtime)
 Remediation Impact (cost, time, labor, Remediation Impact (cost, time, labor, 

production delays)production delays)
►Control Theory Models (Preliminary Work)Control Theory Models (Preliminary Work)

 Regulation of Availability/Reliability ObjectivesRegulation of Availability/Reliability Objectives
 Reasoning about StabilityReasoning about Stability
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Fault-Injection ExperimentsFault-Injection Experiments

►ObjectiveObjective
 To inject faults into the components a multi-To inject faults into the components a multi-

component n-tier web application – specifically component n-tier web application – specifically 
the application server and Operating System the application server and Operating System 
componentscomponents

 Observe its responses and the responses of any Observe its responses and the responses of any 
remediation mechanisms availableremediation mechanisms available

 Model and evaluate available mechanismsModel and evaluate available mechanisms
 Identify weaknessesIdentify weaknesses
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Experiment SetupExperiment Setup
Target: 3-Tier Web Application

TPC-W Web-application
Resin 3.0.22 Web-server and (Java) Application Server
Sun Hotspot JVM v1.5
MySQL 5.0.27
Linux 2.4.18

Remote Browser Emulation clients to simulate user loads
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Healing Mechanisms AvailableHealing Mechanisms Available
►Application ServerApplication Server

 Automatic restartsAutomatic restarts
►Operating SystemOperating System

 Nooks device driver protection frameworkNooks device driver protection framework
 Manual system rebootManual system reboot
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MetricsMetrics
►Continuous Time Markov Chains (CTMCs)Continuous Time Markov Chains (CTMCs)

 Limiting/steady-state availabilityLimiting/steady-state availability
 Yearly downtimeYearly downtime
 Repair success rates (fault-coverage)Repair success rates (fault-coverage)
 Repair timesRepair times

►Markov Reward NetworksMarkov Reward Networks
 Downtime costs (time, money, #service visits Downtime costs (time, money, #service visits 

etc.)etc.)
 Expected SLA penaltiesExpected SLA penalties
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Application Server Memory LeaksApplication Server Memory Leaks
►Memory leak condition causing an Memory leak condition causing an 

automatic application server restart every automatic application server restart every 
8.1593 hours (95% confidence interval)8.1593 hours (95% confidence interval)
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Resin Memory-Leak Handler Resin Memory-Leak Handler 
AnalysisAnalysis

► Analyzing perfect recovery e.g. Analyzing perfect recovery e.g. 
mechanisms addressing resource mechanisms addressing resource 
leaks/fatal crashesleaks/fatal crashes
 SS00 – UP state, system working – UP state, system working
 SS11 – DOWN state, system  – DOWN state, system 

restartingrestarting
 λλfailurefailure = 1 every 8 hours = 1 every 8 hours
 µµrestartrestart = 47 seconds = 47 seconds

► Attaching a value to each state Attaching a value to each state 
allows us to evaluate the allows us to evaluate the 
cost/time impact associated with cost/time impact associated with 
these failures.these failures.

Results:
Steady state 
availability: 99.838%
Downtime per year: 
866 minutes



 17

Linux w/Nooks Recovery AnalysisLinux w/Nooks Recovery Analysis
► Analyzing imperfect recovery e.g. Analyzing imperfect recovery e.g. 

device driver recovery using Nooksdevice driver recovery using Nooks
 SS00 – UP state, system working – UP state, system working

 SS11 – UP state, recovering failed  – UP state, recovering failed 
driverdriver

 SS22 – DOWN state, system reboot – DOWN state, system reboot

 λλdriver_failure driver_failure = 4 faults every 8 hrs= 4 faults every 8 hrs

 µµnooks_recovery nooks_recovery = 4,093 mu seconds= 4,093 mu seconds

 µµreboot reboot = 82 seconds= 82 seconds

 c – coverage factor/success ratec – coverage factor/success rate
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Resin + Linux + Nooks AnalysisResin + Linux + Nooks Analysis
► Composing Markov chainsComposing Markov chains

 SS00 – UP state, system working – UP state, system working

 SS11 – UP state, recovering failed  – UP state, recovering failed 
driverdriver

 SS22 – DOWN state, system reboot – DOWN state, system reboot

 SS33 – DOWN state, Resin reboot – DOWN state, Resin reboot

 λλdriver_failure driver_failure = 4 faults every 8 hrs= 4 faults every 8 hrs

 µµnooks_recovery nooks_recovery = 4,093 mu seconds= 4,093 mu seconds

 µµreboot reboot = 82 seconds= 82 seconds

 c – coverage factorc – coverage factor
 λλmemory_leak_ memory_leak_ = 1 every 8 hours= 1 every 8 hours

 µµrestart_resin restart_resin = 47 seconds= 47 seconds

Max availability = 99.835%
Min downtime = 866 minutes
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Proposed Preventative Proposed Preventative 
MaintenanceMaintenance

► Non-Birth-Death process with 6 states, 6 Non-Birth-Death process with 6 states, 6 
parameters:parameters:
 SS00 – UP state, first stage of lifetime – UP state, first stage of lifetime

 SS11 – UP state, second stage of lifetime – UP state, second stage of lifetime

 SS22 – DOWN state, Resin reboot – DOWN state, Resin reboot

 SS33 – UP state, inspecting memory use  – UP state, inspecting memory use 

 SS44 – UP state, inspecting memory use – UP state, inspecting memory use

 SS55 – DOWN state, preventative restart – DOWN state, preventative restart

 λλ2ndstage 2ndstage = 1/6 hrs= 1/6 hrs  

 λλfailure failure = 1/2 hrs= 1/2 hrs

 µµrestart_resin_worst restart_resin_worst = 47 seconds= 47 seconds

 λλinspect inspect = Memory use inspection rate= Memory use inspection rate

 µµinspect inspect = 21,627 microseconds= 21,627 microseconds

 µµrestart_resin_pm restart_resin_pm = 3 seconds= 3 seconds
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Benefits of CTMCs + Fault InjectionBenefits of CTMCs + Fault Injection
► Able to model and analyze different styles of Able to model and analyze different styles of 

self-healing mechanismsself-healing mechanisms
► Quantifies the impact of mechanism details Quantifies the impact of mechanism details 

(success rates, recovery times etc.) on the (success rates, recovery times etc.) on the 
system’s operational constraints (availability, system’s operational constraints (availability, 
production targets, production-delay reduction production targets, production-delay reduction 
etc.)etc.)
 Engineering view AND Business viewEngineering view AND Business view

► Able to identify under-performing mechanismsAble to identify under-performing mechanisms
► Useful at design time as well as post-productionUseful at design time as well as post-production
► Able to control the fault-ratesAble to control the fault-rates
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Caveats of CTMCs + Fault-InjectionCaveats of CTMCs + Fault-Injection
► CTMCs may not always be the “right” toolCTMCs may not always be the “right” tool

 Constant hazard-rate assumptionConstant hazard-rate assumption
►May under or overstate the effects/impactsMay under or overstate the effects/impacts
►True distribution of faults may be differentTrue distribution of faults may be different

 Fault-independence assumptionsFault-independence assumptions
►Limited to analyzing near-coincident faultsLimited to analyzing near-coincident faults
►Not suitable for analyzing cascading faults (can we Not suitable for analyzing cascading faults (can we 

model the precipitating event as an approximation?)model the precipitating event as an approximation?)
► Some failures are harder to replicate/induce than Some failures are harder to replicate/induce than 

othersothers
 Better data on faults could improve fault-injection toolsBetter data on faults could improve fault-injection tools

► Getting detailed breakdown of types/rates of Getting detailed breakdown of types/rates of 
failuresfailures
 More data should improve the fault-injection More data should improve the fault-injection 

experiments and relevance of the resultsexperiments and relevance of the results
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Real-World Downtime Data*Real-World Downtime Data*
►Mean incidents of unplanned downtime in Mean incidents of unplanned downtime in 

a year: 14.85 (n-tier web applications)a year: 14.85 (n-tier web applications)
►Mean cost of unplanned downtime (Lost Mean cost of unplanned downtime (Lost 

productivity #IT Hours): productivity #IT Hours): 
 2115 hrs (52.88 40-hour work-weeks)2115 hrs (52.88 40-hour work-weeks)

►Mean cost of unplanned downtime (Lost Mean cost of unplanned downtime (Lost 
productivity #Non-IT Hours): productivity #Non-IT Hours): 
 515.7 hrs** (12.89 40-hour work-weeks)515.7 hrs** (12.89 40-hour work-weeks)

* “IT Ops Research Report: Downtime and Other Top Concerns,” 
StackSafe. July 2007. (Web survey of 400 IT professional panelists, US Only)
** "Revive Systems Buyer Behavior Research," Research Edge, Inc. June 2007 
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Proposed Data-Driven Evaluation (7U)Proposed Data-Driven Evaluation (7U)
► 1. Gather failure data and specify fault-model1. Gather failure data and specify fault-model
► 2. Establish fault-remediation relationship2. Establish fault-remediation relationship
► 3. Select fault-injection tools to mimic faults in 13. Select fault-injection tools to mimic faults in 1
► 4. Identify Macro-measurements4. Identify Macro-measurements

 Identify environmental constraints governing system-Identify environmental constraints governing system-
operation (availability, production targets etc.)operation (availability, production targets etc.)

► 5. Identify Micro-measurements5. Identify Micro-measurements
 Identify metrics related to specifics of self-healing Identify metrics related to specifics of self-healing 

mechanisms (success rates, recovery time, fault-mechanisms (success rates, recovery time, fault-
coverage)coverage)

► 6. Run fault-injection experiments and record 6. Run fault-injection experiments and record 
observed behaviorobserved behavior

► 7. Construct pre-experiment and post-experiment 7. Construct pre-experiment and post-experiment 
modelsmodels
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The 7U-Evaluation MethodThe 7U-Evaluation Method
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Preliminary Work – Control ModelsPreliminary Work – Control Models

►ObjectiveObjective
 Can we reason about the stability of the system Can we reason about the stability of the system 

when the system has multiple repair choices for when the system has multiple repair choices for 
individual faults using Control Theory?individual faults using Control Theory?

 Can we regulate availability/reliability Can we regulate availability/reliability 
objectives?objectives?

 What are the pros & cons of trying to use What are the pros & cons of trying to use 
Control Theory in this context?Control Theory in this context?
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Preliminary Work – Control DiagramPreliminary Work – Control Diagram

Expected Downtime = f(Reference/Desired Success Rate)
Measured Downtime = f(Actual Success Rate)
Smoothed Downtime Estimate f(Actual Success Rate)
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Preliminary Work – Control ParametersPreliminary Work – Control Parameters

► D_E(z) – represents the occurrence of faults D_E(z) – represents the occurrence of faults 
 Signal magnitude equals worst case repair time/desired Signal magnitude equals worst case repair time/desired 

repair time for a faultrepair time for a fault
► Expected downtime = f(Reference Success Rate)Expected downtime = f(Reference Success Rate)
► Smoothed downtime estimate = f(Actual Success Smoothed downtime estimate = f(Actual Success 

Rate)Rate)
► Downtime error – difference between desired Downtime error – difference between desired 

downtime and actual downtime incurreddowntime and actual downtime incurred
► Measured Downtime – repair time impact on Measured Downtime – repair time impact on 

downtime. downtime. 
 0 for transparent repairs or 0 < r <= D_E(k) if not0 for transparent repairs or 0 < r <= D_E(k) if not

► Smoothed Downtime Estimate – the result of Smoothed Downtime Estimate – the result of 
applying a filter to Measured Downtimeapplying a filter to Measured Downtime
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Preliminary SimulationsPreliminary Simulations

► Reason about stability of repair selection 
controller/subsystem, R(z), using the poles of 
transfer function R(z)/[1+R(z)H_R(z)]

► Show stability properties as expected/reference 
success rate and actual repair success rate vary

► How long does it take for the system to become 
unstable/stable
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Preliminary Work – Desired GoalPreliminary Work – Desired Goal

► Can we extend the basic model to reason 
about repair choice/preferences?
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ConclusionsConclusions
► Dynamic instrumentation and fault-injection lets Dynamic instrumentation and fault-injection lets 

us transparently collect data “in-situ” and us transparently collect data “in-situ” and 
replicate problems “in-vivo”replicate problems “in-vivo”

► The CTMC-models are flexible enough to The CTMC-models are flexible enough to 
quantitatively analyze various styles and quantitatively analyze various styles and 
“impacts” of repairs“impacts” of repairs

► We can use them at design-time or post-We can use them at design-time or post-
deployment timedeployment time

► The math is the “easy” part compared to getting The math is the “easy” part compared to getting 
customer data on failures, outages, and their customer data on failures, outages, and their 
impacts.impacts.
 These details are critical to defining the notions of These details are critical to defining the notions of 

“better” and “good” for these systems“better” and “good” for these systems
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Future WorkFuture Work
► More experiments on an expanded set of More experiments on an expanded set of 

operating systems using more server-operating systems using more server-
applicationsapplications
 Linux 2.6Linux 2.6
 OpenSolaris 10OpenSolaris 10
 Windows XP SP2/Windows 2003 ServerWindows XP SP2/Windows 2003 Server

► Modeling and analyzing other self-healing Modeling and analyzing other self-healing 
mechanismsmechanisms
 Error Virtualization (From STEM to SEAD, Locasto et. Error Virtualization (From STEM to SEAD, Locasto et. 

al Usenix 2007)al Usenix 2007)
 Self-Healing in OpenSolaris 10Self-Healing in OpenSolaris 10

► Feedback control for policy-driven repair-Feedback control for policy-driven repair-
mechanism selectionmechanism selection
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Questions, Comments, Queries?Questions, Comments, Queries?

Thank you for your time and attentionThank you for your time and attention

For more information contact:For more information contact:
Rean GriffithRean Griffith

rg2023@cs.columbia.edurg2023@cs.columbia.edu
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Extra SlidesExtra Slides
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How Kheiron WorksHow Kheiron Works
►Key observationKey observation

 All software runs in an execution environment All software runs in an execution environment 
(EE), so use it to facilitate performing (EE), so use it to facilitate performing 
adaptations (fault-injection operations) in the adaptations (fault-injection operations) in the 
applications it hosts.applications it hosts.

►Two kinds of EEsTwo kinds of EEs
 Unmanaged (Processor + OS e.g. x86 + Unmanaged (Processor + OS e.g. x86 + 

Linux)Linux)
 Managed (CLR, JVM)Managed (CLR, JVM)

►For this to work the EE needs to provide 4 For this to work the EE needs to provide 4 
facilities…facilities…
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EE-SupportEE-Support

IMetaDataImport, 
IMetaDataEmit APIs

Custom classfile 
parsing & editing 
APIs + JVMTI
RedefineClasses

N/A for 
compiled 
C-programs

Metadata 
augmentation

Assembly, type & 
method metadata + 
MSIL

Classfile constant 
pool + bytecode

.symtab, .debug 
sections

Execution unit 
metadata

MSIL rewritingBytecode rewritingTrampolines + 
Dyninst

Program 
control

ICorProfilerInfo
ICorProfilerCallback

JVMTI callbacks + 
API

ptrace, /procProgram 
tracing

CLR 1.1JVM 5.xELF Binaries

Managed Execution EnvironmentUnmanaged 
Execution 
Environment

EE Facilities
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Kheiron/CLR & Kheiron/JVM OperationKheiron/CLR & Kheiron/JVM Operation

SampleMethod

Bytecode
Method
body

SampleMethod

Bytecode
Method
body

_SampleMethod SampleMethod

New
Bytecode
Method
Body

Call
_Sample
Method

_SampleMethod

Bytecode
Method
body

A B C
Prepare
Shadow

Create
Shadow

SampleMethod( args ) [throws NullPointerException]
    <room for prolog>
    push args
    call _SampleMethod( args ) [throws NullPointerException]
    { try{…} catch (IOException ioe){…} } // Source view of _SampleMethod’s body
    <room for epilog>
    return value/void
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Kheiron/CLR & Kheiron/JVM Fault-Kheiron/CLR & Kheiron/JVM Fault-
RewriteRewrite
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Kheiron/C OperationKheiron/C Operation

Kheiron/C

Dyninst API

Dyninst Code

ptrace/procfs

void foo( int x, int y)
{
    int z = 0;
}

Snippets
C/C++ 

Runtime 
Library

Points

ApplicationMutator
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Kheiron/C – Prologue ExampleKheiron/C – Prologue Example
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Kheiron/CLR & Kheiron/JVM Kheiron/CLR & Kheiron/JVM 
FeasibilityFeasibility

Kheiron/CLR Overheads
when no adaptations active

Kheiron/JVM Overheads
when no adaptations active
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Kheiron/C FeasibilityKheiron/C Feasibility

Kheiron/C Overheads
when no adaptations active
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Kheiron SummaryKheiron Summary
►Kheiron supports contemporary managed Kheiron supports contemporary managed 

and unmanaged execution environments.and unmanaged execution environments.
►Low-overhead (<5% performance hit).Low-overhead (<5% performance hit).
►Transparent to both the application and Transparent to both the application and 

the execution environment.the execution environment.
►Access to application internalsAccess to application internals

 Class instances (objects) & Data structuresClass instances (objects) & Data structures
 Components, Sub-systems & MethodsComponents, Sub-systems & Methods

►Capable of sophisticated adaptations.Capable of sophisticated adaptations.
►Fault-injection tools built with Kheiron Fault-injection tools built with Kheiron 

leverage all its capabilities.leverage all its capabilities.
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Quick Analysis – End User ViewQuick Analysis – End User View
► Unplanned Downtime (Lost productivity Non-IT Unplanned Downtime (Lost productivity Non-IT 

hrs) per year: 515.7 hrs (30,942 minutes).hrs) per year: 515.7 hrs (30,942 minutes).
► Is this good? (94.11% Availability)Is this good? (94.11% Availability)

► Less than two 9’s of availabilityLess than two 9’s of availability
 Decreasing the down time by an order of magnitude Decreasing the down time by an order of magnitude 

could improve system availability by two orders of could improve system availability by two orders of 
magnitudemagnitude


